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Introduction to OPAC 

The purpose of this workflow-based reference guide is to provide information 
on the Online Public Access Catalog subsystem of the Virtua ILS – Integrated 

Library System highlighting the diverse searching methods supported in the 
module and providing instructions for locating records.  

The Virtua client OPAC provides various types of searches, such as Browse, 
Heading and Keyword for library staff. In addition, staff may choose to 

search by common indexes, such as title, subject and author, while also 
allowing for staff restricted searches not allowed in the OPAC available to the 

patrons.  

The client OPAC may be used as the starting point for many of the tasks that 
you will perform in Virtua, including circulation control and cataloging.  

Please contact VTLS Customer Support for more information or if you would 

like to see an OPAC training video. 
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Understanding Menu &Toolbars 

OPAC Menu Options 

 

OPAC Menu & Toolbar 
Menu Bar Icon Function Keys Function 

    
Search    Opens Search window  

Search by State   Search by record state 

Author   Author Search 

Title  F9 Title Search 

Subject   Subject Search 

Call Number   Call Number Search 

Patron Name  F8 Patron Name search (last name first) 

Keyword  F12 Keyword Search 

ISSN   Opens record in View Record window 

LCCN   LC Control Number Search 

Patron Barcode  F2 Patron Barcode Number Search 

Item Barcode  F3 Item/Barcode number search 

ISSN Serials  F10 Opens Serial Checkin window 

Serial Abbreviation    

Instructor    Reserve search by instructor name 

Course ID   Reserve search by course number 

Options    

Change Location    Change Login Location 

OPAC Display  
 

 

 

 Displays or hides Blind References, 
Authority Source, and Heading Type 

Displays a list of connections for the 
client 
Refreshes the connection 

 
Note:  When used with the Alt key, underlined letters denote keyboard shortcuts 

For example: Alt + s + a performs an author search. 
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OPAC Options 
Language and Directionality options can be set from the Options pull-
down menu. 

Language 

 
Select a language from the menu list; click on the Options menu, select the 

Language option, and choose the appropriate language. 
 

Any translated strings for that language will appear in the Client interface. 
There are currently twelve complete translations for Virtua. 
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Directionality  

 

Select directionality from the menu list; click on the Options menu, select 
the Directionality option, and choose the appropriate directionality. 

 

        
 
Directionality Meaning 

Left to Right All text, regardless of directionality, will left justify. 

Left to Right Soft Text that is left-justified text will display left 
justified and right-justified text will display to the 

right. 

Right to Left All text, regardless of directionality, will right 

justify. 
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Documentation and Help 
Virtua Users Guides are available in searchable .pdf format from the Tools 

menu; click on the Tools menu, then select Documentation Search 
Engine. 

 

 
 
Note: While the Documentation Search Engine appears on your Tools menu 

by default, it is functional only if the Virtua documentation has been installed 
via the Documentation Installer. For details on the Documentation Search 

Engine, see the section Viewing and Searching the Virtua Documentation in 
the Virtua Client Getting Started Primer. 
 

MARC 21, CATMARC, SWEMARC, and UNIMARC Format help is available 
from the Help Menu; click on the Help menu and select the appropriate help 

category. 
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Context sensitive help is available; from the window for which help is 
needed, using the F1 key or right mouse click will bring forward more 

information regarding that portion of the window. 
 

 
 

 
The Window menu tracks the order in which open Virtua windows were 
accessed. 
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Connect to Virtua 
 

Recommended 
Workflow 

 
Explanation 

 The first step in using Virtua is configuring a connection 
to your library; you may also configure connections to 
other Z39.50 library databases.   

 

Summary 

Start Virtua 
Configure a Connection 
Connect to Virtua 

 

Key Terms 

Attribute Configuration 
Default Load Character Set 

Host Name 
Port 
Profile Name 

Z39.50 Database 
Z39.50 Protocol 

 

Related Topics 

Users 

Permissions 
Guest 

Open 

Virtua 

Setup 

Connection 

Select 

Database 

Login 
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 Start Virtua  

To open the Virtua Client; either click the Virtua Client icon or select 
Start  Programs  VTLS Virtua. The Connect to Server window 

appears displaying the databases available for connection.  
 

 

Configure a Connection 
 

To add databases to the connection list, click on the Setup button to 
display the Server Setup window.   
 

 
 

Click the New button to create a new connection. The word *New will 
appear in the Profile box to the left. 
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Select *New from the Profile list, then enter the Profile Name (New will 

be put in by default, but you will want to change that to a more 
appropriate name). 

 
Enter the following information: 
 

Description (the name that will appear in the Connection List box),  
Host name or IP address of the database, and  

Port number of the database. 
 

Note: The Database textbox should either contain the word DEFAULT or 

should be left blank to connect to Virtua databases. 
 

 
 

Optional Settings 
 

You may select a color for the section of the menu bar in Virtua that displays 
the database connection information. 
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If a server returns records in a syntax other than MARC 21, Virtua uses the 
syntax specified here. Currently, the Virtua client accepts records from a 

server in MARC 21, CATMARC, and UNIMARC formats. In the Preferred 
Record Syntax text box, type the Object Identifier (OID) for your preferred 

record syntax. 
 
This setting specifies the character set the server to which you are 

connecting. If MARC21 is selected, records will be converted to UTF8 when 
you download records from that server to your Virtua server. 

 
In order for Virtua to search non-standard Z39.50 databases, you will 
need to specify search types and use attributes in the Attribute 

Configuration area.  Configure a use attribute in the New Attribute 
boxes and click the Add button.  The attribute will appear in the Attribute 

Configuration area. 
 

Click OK to return to the Connect to Server window. 

 
Note: If you click Apply, you will then need to click the Cancel button to 

exit the Setup window.  You should not lose the connection information if 
you follow this workflow. 

Select a Database 
 

From the Connect to Server window click on the desired database (there 
may only be one). It will be highlighted indicating that it is selected. 

 

 
 

Click on the Connect button to open a connection, the Virtua Access 

window will appear. 
 

Login 

Guest Login 

The Virtua Access window defaults to Guest.  This profile allows users to 
log in to the Virtua Client without authentication.  
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Click OK to login as Guest.  

 

 
 

System Login 

 
To login with a user ID and password, click in the User ID text box. 

System Login will be enabled. 
 

Type your Username and Password. Click OK to login.  
 

 
  

Open Multiple Connections 

 
Virtua supports connections to multiple databases. 
 

To open multiple connections, select File  New Connection from the 
Virtua Menu bar.  A list of all configured connections will appear. 
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Select the connection you wish to open and click the Connect button. The 

new connection will become the default connection. 
 

Note: The default database is the one that will be active, (e.g. You will be 
able to search that database, retrieve MARC records, and if you have 
permission, update the database). 

 
To change the default connection, select File  Connection List; the List 

of Connections window will appear. 
 

 
 

Highlight the connection you wish to be active, and click the Set Default 
button. 

Close Connections 
 
To close a connection, select File  Close Connection from the Virtua 
menu; the active (default) connection will close. 
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Browse Search 
 

Recommended 
Workflow 

 
Explanations 

 Virtua’s Browse Search takes advantage of a library’s 
controlled vocabulary and cross-reference structure. The 
browse search feature is useful for searching the OPAC 

when the user wants to narrow a search from a broad 
topic to a specific topic or does not know an exact term.    

Summary 

Open the Browse Search window 
Select an index 

Enter search terms 
Navigate the search results 

Navigate View Record window 
Navigate item Information window 

Key Terms 

Authority Headings 
Bibliographic MARC 

Record 
Bib-level Call Number 

Browse Search 
Browse window 
Call number 

Course ID 
Full tab 

Holdings tab 
Holdings-level Call 

Number 

Item 

Item Information 
window  

Item-Level Call 
Number 

Items Elements tab 
Items tab 
List of Titles window 

MARC tab  
MARC 856 tag 

Search window 
Sort Order 
Statistics tab 

Statuses tab 
View Record window 

Search Strings 

Author, Instructor, Patron: Last name first 
Title: Do not include A, An, The as the first word 

Subject: Type the category as it appears in the Library 
of Congress Subject Headings 

Course ID searches: Use the official name and number 
 

Enter 

Search 
Criteria 

Navigate 

Search 

Results 

View 

Records 

Output 

Records 
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Search the OPAC 

Click the Search  icon on the OPAC toolbar or the Search drop-down 
menu to select one of the search options, or use the assigned function 
key (i.e. to perform a Title search hit the F9 key) to open the OPAC 

Search window. 
 

 
 

If you clicked on the OPAC Search icon, the Search window appears with 
Browse as the active tab. 

 
Select an index from the dropdown menu of the index selection box.   

 

        
 

Enter search terms in the text box to the right of the index selection box. 
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(Optional) Click the Location button to filter search types by Location. 
Highlight a single location or select several locations by using the Ctrl key, 

then click OK to accept your location(s) selection. 
 

 
 
Note: Location filter applies to all search types. Using the browse location 
filter for call number searches, you can search by call number and display 

only those items that belong to your library in call number order; creating a 
shelf list. The location filter is inclusive, meaning that your search results will 

include only the items and holdings records that are shelved at the 
location(s) that you select on the Location Filter window. 
 

Click the Search button to perform a search of the database. 
 

To turn off location filtering, click on the Location button from the 
Search window. 

 

Click Clear from the Location Filter window. 
 

Profiler Tip: Library-defined browse and heading keyword search definitions 
are set in the Tags Indexed for User Defined Search parameter in the Virtua 

Profiler. A library-defined search is a type of custom heading search for which 
your library can determine indexing rules. You can determine which 
tag/subfield/indicator combinations are indexed for your library-defined 

search. See Defining Tags Indexed for User Defined Searches in the Virtua 
Profiler/Cataloging Parameters User’s Guide for more information. 

 
(Optional) Click the Collection Groups button to filter search types by 
collection group. Highlight a single collection group or select several 

collection groups by using the Ctrl key, then click OK to accept your 
selection. 
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Note: The Collection Groups filter is available for the Browse and Heading 

search types. The Collection Groups filter is inclusive, meaning that your 
search results will include only the records that belong to the collection 

group(s) that you select on the Collection Groups Filter window. 
 

Click the Search button to perform a search of the database. 

 
To turn off collection group filtering, click on the Collection Groups 

button from the Search window. 
 

Click Clear on the Collection Groups Filter window. 

 
Profiler Tip: The Collection Groups filter button is enabled by the “Allow 

collection group filters for browse/heading” setting on the OPAC Basic 
Options window. See the Virtua Profiler/OPAC Parameters User’s Guide for 
information on this setting. After enabling this setting, you must run the 

script PopulateCollectionGroupFilters.sh. This will populate the Collection 
Groups Filter window with the collection groups defined in the Collection 

Code Group parameter; see the Virtua Profiler/Cataloging Parameters User’s 
Guide for information. 
 

 
(Optional) Click the Item Class button to filter search types by item class. 

Highlight a single item class or select several item classes by using the Ctrl 
key, then click OK to accept your selection. 
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Note: The Item Class filter is available for the Browse and Heading search 

types. The Item Class Groups filter is inclusive, meaning that your search 
results will include only the records that belong to the item class(es) that you 

select on the Item Class Filter window. 
 

Click the Search button to perform a search of the database. 

 
To turn off item class filtering, click on the Item Class button from the 

Search window. 
 

Click Clear on the Item Class Filter window. 

 
Profiler Tip: The Item Class Filter button is enabled by the “Allow item 

class filters for browse/heading” setting on the OPAC Basic Options window. 
See the Virtua Profiler/OPAC Parameters User’s Guide for information on this 
setting. After enabling this setting, you must run the script 

PopulateItemClassFilters.sh. This will populate the Item Class Filter 
window with the item classes defined in the Item Class Definitions 

parameter; see the Virtua Profiler/Circulation Parameters User’s Guide for 
information. 
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Navigate Search Results 
The results of a Browse search are displayed as an alphabetical list of hits 

from the catalog.  In the case of an author, title, or subject search, the list 
consists of authority headings.   
 

 
 

Note: For Author searches, a normalized version of the name appears as 

a hyperlink above the list of hits. 
 

If an exact match for the search term is found, the search term will be 

highlighted. 
If an exact match for the search term is not found, the term above 

where the searched term would be is highlighted. 
      

Term Definition 

Hits Number of titles associated with each line item 

Cross-Reference If the line item is associated with a cross-
reference, the Hits column displays a sign (see 

also reference) or sign (see reference) 

Search Result 

Tabs 

Displays previous search results provided the 

Browse window is not closed 

View Displays additional information about the 

selected item 

PageUp/PageDown Displays the previous page in the browse list 

Skip Skips to the top, bottom, or skips x number of 

entries in the browse list 
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Delete Deletes the active search tab 

To navigate search results: 
 

Select an item with more than one hit.  
 

Click the View button or double click on the item to retrieve the List of 

Titles window. 
 

  
       
The List of Titles window displays the brief record information for each title 
associated with the line item you selected from the Browse window. The 

bibliographic information that appears is defined in the List of Titles View 
record in the MARC View Editor in the Virtua Profiler. 

 
Note: If there is only one hit, this screen is bypassed and the record will 
open in the View Bibliographic Record window. 
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To sort the titles, click on the Sort button. The Sort Selection dialog box 
appears. 

 

        
 

Publication Date (Subsort: Title) and Ascending order are selected by default. 
 

In the Sort Key field, select the radio button for the type of sort you want 

to use. 
 

In the Sort Order field, select the radio button for the order in which you 
want the results to be sorted: Ascending or Descending. 

 

Click OK. Virtua re-sorts the list of titles according to the specified 
criteria. 

Refine a Search 
 

When you search for a topic, which has a long list of titles, you may wish 
to refine your search by adding additional criteria.    

 
From the List of Titles window, click on the Refine button; the Refine 
Search window will appear. 
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Note: Your original search appears at the top of the screen. 
 

Select a category for the first term, then type the first term in the text 
box. 

 

       
 

If a second refinement term is to be used, select a Boolean Operator 

(AND, OR, AND NOT) and category for the second term, then type the 
second term in the middle text box. 

 
Click the Search button to execute the refined search; the List of Titles 
window will appear.   
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Once you have selected a title to view, click on the title. The full view of 
the bibliographic record will appear in the View Bibliographic Record 

window. 
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View a Record 
 
The View Bibliographic Record window provides information about the 

title/item that was selected from the List of Titles.  Information concerning 
the record is displayed on tabs.  Different tabs are available for each record 
type in each different window: 

 
View Bibliographic Record Window Item Information Window 

Full tab Item Elements tab 
Items tab – Access to Item Information 

window 

Notes tab 

MARC tab Statistics tab 
Statuses tab – Acquisitions information Status tab 

Holdings tab – Serials records only  
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Full Tab 
The Full tab view is the non-MARC, public view of the bibliographic record. 
You can configure the bibliographic information that is displayed by editing 

the View Bibliographic Record: Full Display View record in the MARC View 
Editor in the Virtua Profiler. 
 

Click the Full tab. The Full tab of the View Bibliographic Record 
window displays bibliographic information such as author, title, call 

number, subjects, etc. 
 

 
 

 
Label Description 

Agency Request Places a request for multiple copies of a bibliographic record 

Edit Opens MARC Editor window to edit record 

Request Bib Opens Request window to place a bibliographic level request 

Add Item Opens the Add Item window to add an item to the bib record 

Refresh Refreshes to screen 

Close Closes the window 

 
The Full tab of the View Bibliographic Record window contains the 
following areas: 

 
Library Defined Information: Using the Virtua Profiler, your library 

can determine which tabs appear to which user, the names of the 
tabs, and the bibliographic information that appears on the Full tab.  
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Requests: In the lower left corner of the window the number of 
requests (if any) for this title is displayed. 

 
The Full tab of the View Bibliographic Record window may also contain 

hyperlinked text. 
 

Multimedia Links:  If a bibliographic record is associated with 

multimedia files (856 tag), the URL of each multimedia file is 
displayed as a hyperlink.  

Search Hyperlinks:  The Full tab view may be configured in the Virtua 
Profiler to display the contents of any bibliographic tag as a search 
hyperlink. When you click the hyperlinked field, Virtua launches the 

type of search you configured.   
            

 
 

Example: Click on the hyperlinked subject of Poe, Edgar Allen, 1809-
1849. The Browse Search opens, launching a search for subject, Poe, 
Edgar Allen, 1809-1849. 

 
Click the Items tab. The Items tab of the View Bibliographic Record 

window displays the copies and volumes attached to the bibliographic 
record. 

Items Tab 
 

The Items tab consists of two configurable areas: header and list box.  
 

Header: contains information from the bibliographic record and 

associated library-defined labels.   



28 
 

OPAC Workflow-Based Reference Guide   Last Revised: October 2017 

*Updated to 16.1 

List box: contains columns of information about the various physical 
copies of the item. 

 

 
 

Depending on how you configure the View Bibliographic Record/View 
Holdings Record: Items Tab View record in the Virtua Profiler, the 
information displayed may include: 

 
Label Description 

List of Items Physical and/or virtual items attached to bibliographic record  

Item Level URL If the item record has a URL an icon displays to the left of the 
call number. 

Call number(s)  Shelving location number 

Location Where items are located  

Status Items available, on reserve, or which have outstanding 

requests 

Item number Barcode of the item 

Units Number of discrete pieces associated with the item  

Circulation Data Tallies, or counts, of items with specific statuses 

Requests Number of outstanding requests for an item 

Masked If checked, the record will not display to users without 
permission 

 

Sorting on the Items Tab 

 
Click the column headings to sort the information in that column. Each 
category sorts the items alphabetically in ascending order. 
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When new items are added, the default sort placement is the last item in the 
list.  If a user clicks on the Units column heading to change the sort order, 

the system will only reverse the order of the items.  That is, the items going 
down the list would, after clicking the Units column, now be at the bottom of 

the list and will go up. If that new item is not in the desired sort order, then 
the user will use the Change Order feature to place the new item into the 
correct sorted order. 

 
The Change Order feature allows the staff user to define a sort order for the 

display of items on the View Bibliographic Record window or the View 
Holdings Record window in the Virtua client. 
 

To change the order in which items display on the View Bibliographic 
Record window: 

 

 
 

Select an item in the list. 
 

Right click and select the Change Order option. 
 

Change the order of the items (Units field values are in the list) by 
selecting the item and using the up and/or down arrows to change the 
position. 
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Click the Apply button. 

Re-sorting Items By Units 

 
Re-sort the list of items on the Items tab of the View Bibliographic 
Record window or the View Holdings Record window by the items’ Units 

values. Re-sorting is especially useful when the item list contains items of 
different volumes and the volumes are identified with non-traditional Units 

values (such as Roman numerals). 
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To resort the items, select a line item, right click, and select the Change 
Order option, which displays the Change Sort Order window. The 

Change Sort Order window displays Units field data from all the 
associated item records.  

 
Select the item you want to re-sort, and then use the Up and Down 
"hand" icons to move each item as desired.  

 
Apply the changes and the items in the View Bibliographic Record or 

View Holdings Record window appear in the sort order specified. 

Item Information Window 

 
The Item Information window displays information about a physical or 

virtual piece in the library collection.  While all copies of one title may have 
identical bibliographic information, other types of information, such as 
barcode, are unique and differ from copy to copy. 

 
Each tab contains the same Bibliographic Information at the top of the 

display. You can determine what information appears in the bibliographic 
header and how it is displayed by configuring the Item Information View 
record (20004) in the MARC View Editor in the Virtua Profiler. For details, see 

the Virtua Profiler/OPAC Parameters User’s Guide. 
 

From the View Bibliographic Record window, select an item and click on 
the View Item button. The Item Information window will appear. 
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Tab Description 

Item 

Elements 

Bibliographic, item, and call number information, 

preservation and conservation codes, and circulation 
rules  

Notes Public and staff notes and check-in and check-out 
alerts  

Statistics Information grouped by bibliographic information, 
record information, and circulation statistics 

Status Special or system-defined circulation statuses 

Acquisitions Displays acquisitions information for the item. 

Barcode 
History 

Displays old barcodes for the item, along with the first 
and last dates the barcode was used. 

Button Description 

Delete Deletes the item record 

Edit/Save Displays as Save when in Edit mode to save changes 

Refresh Refreshes the item record display 

Close Closes the item record 
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Item Elements Tab 

 

The Item Elements tab always appears on the Item Information window, 
and it always appears first. On the Item Elements tab, item information is 

organized into four groups:  
 
 

Label Description 

Bibliographic 

Information 

You can determine what information appears in the 

bibliographic header and how it looks by configuring the 
Item Information View record in the Virtua Profiler. 

Item 
Information 

Item Barcode: alphanumeric, up to 50 characters long 
Item Class 

Reserve Item Class 
Location: Owning, or permanent, location of the item 

Shelving Location 
At Shelving Location Until: This field appears only if the 
owning and shelving locations are different. 

Number of Pieces 
Circulate Pieces: If checked, users may specify at check-out 

and check-in how many of the pieces are to be checked out 
or in. 
Price 

Lamination: Provides a drop-down list of values to describe 
the state/type of lamination. 

 
Call Number  Copy: Copy number of the item 

Call #: Primary call number 

Second Call # 
Units area: 

Free Text: text box at the bottom of the Units area will be 
enabled only if you select the Free Text radio button 
Enumeration and Chronology: Available only if the item is 

attached to a holdings record with at least one 853 tag. 
None 

 
Circulation 

Rules 

Use Matrix 

Use Loan Period 
Allow Requests 
 

Note: You can make an item non-circulating by selecting 
the Use Loan Period radio button and setting the period to 0 

(zero). 
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Notes Tab 

The Notes tab displays Public and Staff notes and Check-in and Check-out 

alerts regarding the associated item. If notes are not associated with the 
item, the Notes tab appears only in edit mode. 

 

 
 

 

There are four types of notes: 
 

     
Note Description 

Public Notes Displays to patrons from the OPAC 

Staff Notes Displays only to staff logins 

Checkout Alert Alert box pops up during check-out 

Checkin Alert Alert box pops up during check-in 
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To Add/Edit a note: 
 

Click in a note field to add a note. 
 

Type in the note text, or perform the note edit. 
 

Click the Save button to save the note and exit. 

 
Note:  Public notes in the Client may be displayed on the View 

Bibliographic Record window by configuring the View Record view in the 
Virtua Profiler. Public notes may also display in the iPortal by configuring the 
iPortal View Record view in the Virtua Profiler. 

Statistics Tab 

The Statistics tab displays read-only statistical data about the item. The 

Statistics tab always appears when the Item Information window is in 
view mode.  
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Status Tab 

The Status tab displays the library or system defined circulation status 

attached to an item. When more than one status exists, each line contains a 
different status. 

 

 
 
Column Heading Description 

Status The type of status that applies to the item. Status types 
are defined in the Virtua Profiler 

Date Added Date when the status was created.  The software adds this 
date, which is read-only 

Location/Due 
date 

Location where the status was created.  This field can also 
indicate the location for an item that you have manually 

put in-transit 

To Location The location to which the item is being sent if the status is 

In-transit.  This field displays data only when In-Transit 
is the selected status 

Report # The number of times this status has appeared on a report. 
The system increments the Report number automatically 



37 
 

OPAC Workflow-Based Reference Guide   Last Revised: October 2017 

*Updated to 16.1 

To Add/Edit a Status: 
 

Double click an item to edit a status. The Edit Item Status window 
appears. 

 
Click the Add button to add a new status. The Add New Status window 
appears. 

 
Select a status from the dropdown menu. 

Acquisitions Tab 

The Acquisitions tab of the Item Information window includes the 
following information: date, cost, purchase order number, order line number, 

vendor name, and receipt date. 
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Barcode History Tab 

The Barcode History tab displays information about barcodes that have 

been previously assigned to an item, and only appears when the Maintain 
Item Barcode History parameter is enabled. 

 

 
 
Profiler Tip: The Maintain Item Barcode History setting controls whether 

Virtua maintains a history of the item barcodes that have been assigned to 
any given item. See Details about the Cataloging Basic Options: About the 

Maintain Item Barcode History Setting in the Virtua Profiler/Cataloging 
Parameters User’s Guide for more information.  
 

MARC Tab 
The MARC tab displays the MARC format for the bibliographic record.  Your 
library can choose whether or not this tab will display to OPAC users. 
 

Click the MARC tab. The MARC record will appear. 
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Click the Edit button to open the MARC Record in the MARC Editor 

window. 
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Statuses Tab 
If an item has an acquisitions status, the Statuses tab will appear on the 
View Bibliographic Record window.   

 
Click the Statuses tab to view the acquisitions status for the item. 
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Depending on where the item is in the acquisitions process, some areas of 

the screen may be grayed out. In the example above, the item has been 
ordered but not yet received. 

Holdings Tab 
The Holdings tab displays information about the holdings records that are 

attached to the bibliographic record. From the Holdings tab you can view 
brief information about the holdings records or access additional information 

about each specific holdings record. 
 
The Holdings tab is only associated with serials that have holdings records 

attached.   
 

The Holdings tab consists of two configurable areas: header and list box.  
 

Header: contains elements of the serial bibliographic record and 

associated library-defined labels such as author, title, edition, publisher, 
and description of material. 

List box: contains columns of information taken from each holdings 
record and other records linked to the holdings record. You can determine 
which information appears in the list by configuring the View Record: 

Holdings Header/Item Details View record in the Virtua Profiler. 
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Click the Holdings tab to view the holding record information.  
 

  

Double click on the copy that you wish to view or highlight the copy and 
click the View Bibliographic Record button. The View Holdings 

Record window appears. 

View Holdings Record  

The Full tab of the View Holdings Record window contains holdings 

information from the 863 tag of the MARC Holdings record. 
 

The Full tab consists of two configurable areas:  
 

Bibliographic Header - Displays information associated with the parent 

bibliographic record.  
Holdings Header - Displays information associated with the holdings 

record (below the bibliographic header). 
 
You can configure these headers via the View record for the View Holdings 

Record: Full Display in the MARC View Editor in the Virtua Profiler. You can 
configure the bibliographic header using the Primary Display tab of the MARC 

View Editor. You can configure the holdings header using the Format feature 
of the MARC View Editor. 
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If item records are associated with the holdings record, an Items tab will 

appear on the View Holdings Record window. The Items tab displays a list 
of items that are attached to the current holdings record. 

 
Click the Items tab to view brief information about each item, access 
additional information about each item, and perform various functions for 

specific items. 
 

The Items tab of the View Holdings Record window looks the same and 
offers the same functions as the Items tab on the View Bibliographic 
Record window, except for items with Enumeration and Chronology Units, a 

special re-sort is available. 
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The MARC tab of the View Holdings Record window displays all the fields 
that exist in the holdings record. 

 
Click the MARC tab to view or edit the Holdings Record. 
 

The bibliographic header that is displayed on the MARC tab is identical to the 
bibliographic header on the Full tab of the View Holdings Record window, 

and is defined by the same View. 
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Filtering Items Attached to Holdings Records 

 

To filter items attached to multiple holdings records on the Holdings tab of 
the View Bibliographic Record window click the Item Search button to 

open the Item Units Search dialog box. 
 

 
 
The Item Units Search dialog box lets you search the holdings items 

attached to the bibliographic record according to top-level chronology and 
enumeration. 
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In the Item Units Search dialog box, you can enter a single value in the 
Enumeration Minimum field and/or the Chronology Minimum field, OR you 

can enter a minimum and maximum range for Enumeration and a minimum 
and maximum range for Chronology. Note: Values are numeric only. 

 
To perform a search, type information in one or more of the search fields, 
and click OK. 

 
The results of your search will appear in the Item Unit Search Results 

window. 
 

 
 

Output Records 
 
Copies of bibliographic records can be obtained from the List of Titles, View 
Record, and MARC Editor windows in three ways: 

 
Print 

Save 
Email 

Print Record(s) 

Open the record in the List of Titles, View Record, or MARC Editor 
window.    

  
Highlight the Print option from the File pull-down menu or right click the 

mouse and select Print. 
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The Print window will appear. 

 

 
 
From the drop down menu select the format that you would like to print. 

 
Press the OK button. 

Save Record(s) 

Open the record in the List of Titles, View Record, or MARC Editor 
window.   

 
Highlight the Save option from the File pull-down menu or right click the 
mouse and select Save; The Save Records window will appear. 

 

 
 
Choose the drive or directory to which the record(s) will be saved. 



48 
 

OPAC Workflow-Based Reference Guide   Last Revised: October 2017 

*Updated to 16.1 

 
Type the file name in the text box labeled File Name. 

 
Choose the format for the record(s) by clicking the arrow in the pull-down 

list box labeled Save As Type. 
 
Note: You will have different “Save as Type” options depending upon which 

window/tab you chose. 
 

If you right click from all windows/tab except the Items tab, you will 
have the following options:  

Full 

MARC 
MARC (Binary) 

List of Titles 
 

If you right click from the Items tab, you will have the following options: 

Items Menu List 
Holding Menu List 

 
Click the Save button. 

 
Note: From the List of Titles screen you also have the option to save 
records with 949 tags containing item information. 

Email Record(s) 

Open the record in the List of Titles, View Record, or MARC Editor 

window. 
 

Highlight the Email option from the File pull-down menu or right click the 

mouse and select Email; The Email Records window will appear. 
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Choose a format for the record(s) you are saving by clicking the arrow in 

the pull-down list box labeled Format. 
 

If you are using a non-UTF-8 compliant e-mail client, select the Map to 
ISO-8859-1 check box for proper display of diacritics. 

 

If you want to send email the record(s) as an attachment, select Send as 
Attachment. 

 
Choose the range of records that you want to Email.  

 

Type the information required in the Message Information area. 
 

Click the OK button. 
 
 



50 
 

OPAC Workflow-Based Reference Guide   Last Revised: October 2017 

*Updated to 16.1 

Keyword & Full Text Searching 
Recommended 

Workflow 

 

Explanation 

 

Keyword 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

Full Text  

Virtua Keyword searching has the flexibility to allow the 

novice user to create simple searches, yet allows the 
experienced user to build sophisticated searches through 
Precision Searching and Filtering   using the following 

tools: 
Keywords  

Wild cards 
Parentheses  
Boolean Operators  

Search Categories (including 008 Fixed Fields) 
Phrase searching 

Proximity searching 
Full Text searching 

Summary 

Open the Keyword Search window 
Enter Search Terms and Search Strings 

Select appropriate operators 
Select appropriate search categories 

Refine the Search 
Set Filters 

Key Terms 

Boolean Operators 
Expert Search 

Filters 
Keyword Search 
Refine 

Search Categories 
Search Strings 

Sub-Location 
Truncation  

Enter 
Keyword 

Search 
Criteria 

Refine 
Search 

Set Filters 

View 

Records 

Output 

Records 

Enter 

Phrase 

View Record 

View 
Document 
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Search Commands 
A search command, or query string, is a line of text that consists of a 
combination of: 

 
Keywords 
Search categories 

Wild cards 
Boolean Operators 

Parentheses (for creating groups) 
Phrase searching 
Proximity searching 

Keywords 
Keyword searches let you search for bibliographic records that contain one 
or more keywords in an indexed field, fixed field, or Leader position.  
 

In bibliographic keyword search queries, you can use any term that you want 
in order to find it in the index for a given category. You can use: 

 
Alphanumeric words: for example, 1900s 
Numbers: for example, 1984 

Letters: for example, MS 
Word list: for example, civil war 

There is an implied AND between terms in the word list 
There is no order to the terms in the word list  (it is not a phrase 

search) 

Truncation 
Within keywords, you can specify left or right truncation along with wild card 
searches. 

 
Words truncated with an asterisk (*): Designate one or more characters. 
 

Example 
Searches 

Virtua Retrieves 

farm* farm, farms, farming, or other words starting with 
farm. 

Wa*n walton, warden, Washington, etc. 

 
Words containing a question mark (?): Use a question mark (?) to 
designate a single character per question mark. Use two question marks to 

designate two characters, etc. 
 

Example 
Searches 

Virtua Retrieves 
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Ho?  hop, hog, hot, etc. 

Vi?e  vice, vise, vile, etc. 

Phrase Searching 
Quotation marks are used to denote a phrase. The search returns only 

those records containing all keywords inside the quotation marks, in that 
order. 

     
Example 
Searches 

Virtua Retrieves 

“way of all”  “The way of all women”, “The way of all flesh”, etc. 

Boolean Operators & Search Operators 
Boolean operators (symbols) or Search Operators (terms), are used to 
link two or more keywords.  In Virtua, these operators are available on drop-
down menus or can be used within the text boxes as part of a search string. 

If entering them as part of a search string, you must put a space before and 
after each operator and use a symbol such as & or +.  

 

Symbols Terms 

& AND 

+ OR 

- AND NOT 

&x  NEAR (Proximity searching) 

Parentheses 
You can use parentheses anywhere within a query string to group a set of 

operators and search terms.  Search strings within the parentheses will be 
processed first. 

 
Use the plus (+) and minus (-) signs to include or exclude search terms from 

your group: 
      

Example Search Virtua Retrieves 

(art history) – 
art, greek  

Records that have art AND history as a subject but 
do not have art, Greek as a subject are found. 

 
Use the plus (+) and minus (-) signs within groups: 

       
Example Search Virtua Retrieves 

(t:painting + art) 
& a:mayer  

Records that have painting in the title AND art as a 
subject AND Mayer as an author are found. 
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Use nested logic that combines two sets of terms using two sets of 
parentheses: 

     
Example Search Virtual Retrieves 

 ((art or 
sculpture) & art 

collections)  

 Records that have art OR sculpture as subjects 
AND art collections are found. 

Proximity Searching  
Bibliographic keyword searches let you specify the proximity between 

search terms using either the NEAR operator that or with the & xx operator. 
The value of the x indicates the number of words between the two terms. For 
example, &3 indicates that the keywords are within three words of each 

other. 
     

Example Search Virtua Retrieves 

t:ancient &1 

t:rome  

Records in which ancient appears within one word 

of Rome in any indexed title field are found. 

 

Notes concerning proximity searching: 
 

It is possible within ONE category only. 

It is possible between TWO terms only. 
The search operator OR has no inherent value in a proximity search 

between two terms.  Use OR only in a query string that contains 
parentheses. 

Search Categories 
When specifying a search category, type the category code, followed by a 

colon and the search term. Do not put a space between the category code 
and the colon or between the colon and the search term.  See Appendix D 

for a complete list of search categories. 
 
 a:  author    j:  notes 

 h:  personal name   g:  general 
 i:  corporate name   u:  publisher   

 t:  title    k:  place of publication  
s:  subject    e: everything (ALL indexed fields) 
f:  series 

   
Example Search Virtua Retrieves 

a: Bronte  Records authored by Bronte, Charlotte; Bronte, 
Emily; etc. are found. 
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Enter Search Criteria 
 

Click the Search icon  on the OPAC toolbar or use the Search pull 

down menu from the toolbar. The Search window appears. 
 

Click the Keyword tab; the Keyword Search window appears. 
 

 
 

Select a category for the first term, then type the first term in the text 
box. 

 
If you wish, select a Boolean Operator (AND, OR, AND NOT) and category 

for the second term, then type the second term in the middle text box.  
Repeat for the third row if necessary. 

 

Tip: Use the Help button to display the Keyword Search Help window, 
which offers you information and examples to help you construct precision 

search queries. 
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Click the Search button to execute your search; the List of Titles 
window will appear. 

 

       
 

Sort Records 
 

On the List of Titles window, your search results are displayed using the 
sort order specified in the Default Result Set Sorting parameter in the Virtua 

Profiler. The default Result Set Sorting parameter also allows you to: 
 

Specify whether the selected sort is displayed in ascending or descending 

order.  
Specify a maximum number of hits to sort. Result sets that contain more 

than the specified number of hits will not be sorted. 
 
To sort your search results on the List of Titles window see Browse Search: 

Navigate Search Results.  
 

Profiler Tip: The Max Bib Keyword Search Result Set Size area has two 
options for specifying the size of bibliographic keyword result sets. If you 
specify a value in the Maximum Number of Hits field, the Virtua server will 

truncate any results returned from a bibliographic keyword search that 
exceed the value. See Working with the OPAC Basic Options Parameter: 

Setting the Maximum Size of Result Sets for Bibliographic Keyword Searches 
in the Virtua Profiler/OPAC Parameters User’s Guide for more information.  
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Refine a Search 
 
To refine a search from the List of Titles window see Browse Search: Refine 

a Search. 
 

Set Filters 
 

Filtering options are available for Keyword and Expert searches.  The filter 
option returns information from the fixed fields in the MARC record, set in the 
Virtua Profiler. 

 
On the Search window, click the Options button; the Search Filters 

window appears. 
 

 
  

In the list boxes select one or more filters by clicking each list item in 

turn; use the Control key to select multiple terms. 
 



57 
 

OPAC Workflow-Based Reference Guide   Last Revised: October 2017 

*Updated to 16.1 

 
 
 

Filter Category Description 

Publication Year Date range, currently can only be used to filter on 

1 year.  

Format Format of the work (e.g. map, video, serial). 

Language Language of the publication. 

Context Year Established in tag 945 $a and $b ($a designates 
common era start date and $b common era end 

date for AD dates).  

Nature of 
Contents 

Category of the work (e.g. handbook, dictionary). 

Place of 
Publication 

(e.g. state or country) 

 
Note: The Context Year filter is used to find bibliographic records 

whose topic covers a specified date range.   
 

Example  How to Filter 

The Civil War has 
a date range of 

1861-1865.  

To search on a bibliographic record within the 
context of the Civil War, for a battle that occurred 

in 1864, you would enter a Context Year range of 
1864-1864.   

 
To clear the filters, click the Clear button on the Search Filters window. 

 
When finished, click the OK or Enter button. 

 



58 
 

OPAC Workflow-Based Reference Guide   Last Revised: October 2017 

*Updated to 16.1 

Note:  The software remembers the filters you set.  Once set, the software 
will warn you as you begin each new Keyword or Expert search that filters 

are ON and ask if you want to use them. 
 

Once you have chosen your search categories, Boolean terms, and typed 
in your search terms, click on the Search button. 

 

When you click on the Search button, a confirmation window will appear.  
Choose to include or exclude the selected filter(s). 

 

 
 

If your search term(s) finds one record, the View Record window will 

be displayed. 
If your search term(s) finds multiple records, the List of Titles 

window will be displayed. 

View a Record 
See Browse Search: View a Record.  
 

Output Records 
See Browse Search: Output Records. 

 

Full Text Searching 
In order to allow full text searching, a full text document loader program and 
associated scripts are needed to index full text documents. Please contact 

VTLS Customer Support. 
 

To enable full text searching: 
A bibliographic record is created for the full text document. The user can 

specify a multimedia link in the 856 tag of the bib record or in the 
item record. 

A text file of the document is put on the server. 

The bib id for the associated bibliographic record is specified in the load 
program to link the index of the text file to the bib record. 

View Records 
 

Select Full Text from the Keyword search menu. 
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Enter a phrase of the text from the desired record. 

 

       
 

Click the Search button. 

 
If there is only one matching bib record it will display in the View 

Record window.   

If there are multiple matching bib records, the List of Titles window 
will be displayed. 

 
In the example shown below, the open book icons indicate that there are 
item level URLs. These URLs are links to the full text documents. 
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Click an item in the list to select the item you wish to view.  
 

Click the View URL button; the document will open in the associated 
program.   

 
For example:  The text version of this record is a Word document, so the 
document will display in Word. 

 
Note: You can associate more than one document with a full text index.  For 

example, you might want the full text document as both a text document and 
as an image for handwritten historical documents. 
 

Holdings Keyword Searching 
Holdings keyword search functionality is a special Virtua feature that must be 
configured by VTLS personnel. To enable holdings keyword search 
functionality for your library, contact your local VTLS office. 

 
Holdings keyword searches let you search for holdings records that contain 

one or more keywords in an indexed variable field or fixed field. You can 
construct a holdings keyword search query by combining search categories, 
search operators, and keywords on the Holdings Keyword tab of the 

Search window. 
 

To perform a holdings keyword search: 
 

Click the Search icon  on the OPAC toolbar. 
 

The Search window appears, displaying the Browse tab. 
 

Click the Holdings Keyword tab. 
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Using a combination of keywords, search categories, and search operators, 

construct a holdings keyword search query. 
 

 
 

Click the Search button. Your search results appear on either the 
Holdings window or the View Holdings Record window. 

 
If Virtua finds more than one holdings record that meets your holdings 

keyword search criteria, the records appear on the Holdings window, which 
displays brief information about each of the records. 
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If Virtua finds only ONE holdings record that meets your holdings keyword 

search criteria, it appears on the View Holdings Record window. 
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Authority Heading Searches 
Recommended 

Workflow 

 

Explanation 

 

 
 
 

 
 

 
 
 

 
 

Virtua provides two types of authority heading searches 

beyond the ability to browse subject headings, titles, or 
authors. 
 

Multiple Subject Heading Searches: Virtua can be 
configured to allow the searching of either 

MARC21 defined subject thesauri such as LCSH or 
MeSH as well as library-defined thesauri 

 

Keyword in Heading Searches: Virtua provides the 
functionality to perform keyword searches of 

authority headings. 
 

This lesson will also cover: 
Cross-References 
Display Options 

Summary 

Perform a search using a specific subject thesaurus 

Perform a keyword in heading search 
Distinguish between See and See Also references 
Navigate the Cross Reference screens 

View Authority Records 

Key Terms 

Blind Reference 
Cross Reference  
Display Options 

Subject Thesaurus 
Subject Headings 

MARC Authority Record 
See Also Reference 
See Reference 

 
 

 

Multiple 
Subject 

Headings 

Keyword in 

Heading 

Cross  

References 

Display  

Options 
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Keyword in Heading Search 
 
The Heading tab on the Search window gives users the ability to do 

keyword searching of authority headings in bibliographic and authority 
records.  Users can limit the search by: all words, phrase, or exact match. 
 

From the Search menu click the Search icon  on the OPAC toolbar. 

 
Select the Heading tab. 

 

From the drop-down menus, select a search category and search criteria. 
 

 
 

Enter your search terms in the corresponding textbox.  

 
Click the Location button to filter search types by Location. Highlight a 

single location or select several locations by using the Ctrl key, then click 
OK to accept your location(s) selection. 

 
Click the Search button.  
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An alphabetical list of subject headings containing your search term(s) will 
appear. 

 
Note: Unlike a Browse subject search, where only terms found at the 

beginning of subfield \a of the 6xx tag are retrieved, the Keyword in 
Heading search will retrieve keywords found anywhere in the 6xx tag.  
 

Example: Search results for Keyword in Heading subject search: Civil 
War 

 

 
 

Example: Search results for Browse subject search: Civil War 
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Browse Multiple Subject Headings 
Virtua gives libraries the ability to add menu thesauri searches to the 
Browse search dropdown menu. The authoritative-agency thesauri defined 

by MARC21 are set using the Multiple Subject Headings Parameter in the 
Profiler. (See Appendix E for additional information.) 
 

From the Search menu select the Subject search option or click the 

Search  icon on the OPAC toolbar to open the OPAC in browse mode. 
 

Click the Find dropdown menu. The subject heading searches enabled will 
appear at the bottom of the menu. 
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Your search results will be slightly different from the search results of a 
general subject search.  The example below shows the results of a general 

subject search of Sheep. 
 

Note: Each subject heading has a thesaurus name after it. 
 

 
 
The example below shows the results of a Subject – NAL search of Sheep. 

 
Note: Only the subject headings that have the subject thesaurus name NAL 

(National Agriculture Library) in the general subject search display in the 
Browse window. 
 

 



68 
 

OPAC Workflow-Based Reference Guide   Last Revised: October 2017 

*Updated to 16.1 

Cross-References 
Perform a subject search from the Browse tab; the Browse window will 
appear with a list of terms. In the column labeled Hits, the + (plus sign) 

and – (minus sign) indicate cross-reference information. 
   

Symbol Indication 

+ (plus sign) Indicates a see also cross-reference 

- (minus sign) Indicates a see cross-reference. 

 

Notes:   
A plus sign (+) and a zero (0) in the Hits column indicates a valid 

authority heading that infers a see also reference.  
A zero (0) without a plus or a minus in the Hits column indicates a valid 
authority heading that is not associated a heading in the database.  

A minus sign (-) with a blank in the Hits column indicates an invalid 
authority heading. 

 

 
 



69 
 

OPAC Workflow-Based Reference Guide   Last Revised: October 2017 

*Updated to 16.1 

Click a term with a plus sign.  The Cross References window appears 
displaying a list of related terms.   

 

 
 

Select an entry, right mouse click to view authority record.  
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Close the View Authority Record window and click on the View Button 
in the top right of the window.  A list of title associated with the heading 

will appear. 
 

  
 

Select a related term from the Cross References window and click on 
the View button in the lower part of the window; a list of title related to 
that term appears. 
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You may view notes associated with related terms by selecting a term and 

clicking the Notes button. 
 

 
 

To return to the list of related terms, click the View List button. 
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Display Options 
The OPAC display can be set to display Blind References, Authority 
Source, and Heading Type if the user so chooses.    

 
From the Options menu, click on OPAC Display, and then place a check 
next to the options that you wish to display.   

 

 
 

Blind Reference:  The term is a valid heading but there are no hits/records 
in the database associated with the term. If Blind References are set to 
display, Virtua displays the term with 0 hits next to it.   

 

 
 

Heading Type: The words series or uniform title will display in brackets 
next to appropriate terms. These are derived from the Bib Lvl values 
specified in the 008 tag of the 999 Virtua tag of the authority record. 
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Authority Source: A cataloging code that indicates who created the 

authority record, for example Library of Congress. This is derived from the 
subfield \a of the 040 tag of the authority record. 

 
Authority Browse Filters: All Authority Headings, Permanent Authorities 
Only or Provisional Authorities Only. 
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Control Number Search 
Recommended 

Workflow 

 

Explanation 

 

 
 
 

 
 

 

Control numbers are unique numbers assigned to library 

items or attached to catalog records and subsequently are 
used to identify those items or records.  Virtua indexes 
these numbers so you can use them in a search.  

Searching on a control number will produce a direct hit, 
immediately accessing the items and records.   

Summary 

Open the Control Number tab of the Search window 
Identify search results relating to control numbers 

Key Terms 

Authority MARC Record 

Control Number 
Control Number Search 

Holdings MARC Record 
Item Record 
Patron Record 

Vendor Record 
 

 
 

 
 
 

 

Enter 
Control 

Headings 

View 
Records 

 

Output 
Records 
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Control Numbers and Search Results in Virtua 
 
Index Searches Retrieves 

Auth Ctrl # 010 tag of the Authority Record View (Authority) Record 
window 

Auth ID 001 tag of the MARC Authority 
Record 

View (Authority) Record 
window 

Authority 

LCCN 

035 tag of the Authority Record View (Authority) Record 

window 
Bib ID 001 tag of the MARC Bibliographic 

Record 

View (Bibliographic) Record 

window 
Birth 
Certificate # 

025 tag subfield $a of patron 
records 

Patron Information window 

Control 
Number Link 

773 tag subfield $w to find all 
child (i.e., component part) 

records associated with a 
particular parent analytic record.  

This search is available for 
databases that have MARC 

21 and/or CATMARC records 
only. 

Holdings ID 001 tag of the Holdings Record View Holdings window 

ISBN 020 tag of the MARC Bibliographic 
Record 

List of Titles window or View 
Bibliographic Record 

window 
ISSN 022 tag of the MARC Bibliographic 

Record 
List of Titles window or View 
Bibliographic Record 

window 
ISSN-L 022 tag subfield $l of the MARC 

Bibliographic Record 

List of Titles window or View 

Bibliographic Record 
window 

ISSN Serials 022 tag of the MARC Bibliographic 

Record 

Serials Check-in window or 

the Holdings tab of the View 
Bibliographic Record 

window 
Item 

Accession 
Number 

All item records. The Accession 

Number on the Item Elements tab 
of the Item Information window is 
distinct from the acquisitions 

accession number. 

Item Information window 

Item 

Barcode 

Item barcode number Item Information window 

Item ID System ID number of the Item 
Record 

Item Information window 

LCCN 010 tag of the MARC Bibliographic 
Record 

View (Bibliographic) Record 
window 

Local 
Number 

Searches the exact content of the 
035 of the MARC Bibliographic 
Record tag  

View (Bibliographic) Record 
window 

OCLC 
Number 

035 tag of the MARC Bibliographic 
Record and automatically adds 

View (Bibliographic) Record 
window 
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the (OCoLC) ocm prefix. 
Other 

Standard 
Identifier 

024 tag subfield $a of the MARC 

Bibliographic Record 

List of Titles window or View 

Bibliographic Record 
window 

Passport # 022 tag subfield $a of the Patron 
Record 

Patron Information window 

Patron 

Barcode 

015 tag of the Patron Record Patron Information window 

Patron ID 001 tag of the Patron Record Patron Information window 

Publisher 
Number 

028 tag subfield $a the MARC 
Bibliographic Record 

List of Titles window or View 
Bibliographic Record 
window 

Vendor # System-generated Vendor ID 
number 

View Vendor window 

Search the OPAC 
 

Click the Search  icon on the OPAC toolbar or use the Search pull 
down menu from the toolbar. 

 
Choose one of the control number types listed. 
 

Type the number in the box adjacent to the box containing the search 
term categories. 

 
Press the Search button or Enter on your keyboard.  
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Note: Depending on the type of control number search performed, different 

windows may appear. Since control numbers are unique, you should only 
retrieve one record. 
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Masked Records  
Recommended 

Workflow 

 

Explanation 

 

 Masked Records  

Comprehensive record masking is available in Virtua. 
This feature can be used to hide records that have been 
added to selection lists or are on order. Bibliographic 

records, item records, and holdings records can be 
masked. 

Masked records are not visible in the public OPAC.  
The ability to view and/or create masked records 

can be in the Profiler. 

Optional setting in profiler: Masking is removed 
when items are received. 

Summary 

Mask a Record 

Key Terms 

Masked Record 

Related Topics 

Users 
Permissions 

Guest 

Masked Record Parameters 

Acquisitions Basic Options: Automatically 

unmask records on receipt. 
Operational Security: Permissions can be set to 

allow users to View, and/or Edit masked records. 
 
 

 

Masking  
Records 

Display 
Masked 

Records 
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Create Masked Records 
 
Bibliographic records may be masked so that they are not visible in the 

public OPAC, or to staff members without permission to see masked records. 
 
Bibliographic Records can be masked from several places in the Virtua Client:  

 
View Bibliographic Record Window 

Item Information Window 
View Holdings Record Window 
MARC Editor Window 

Add Purchase Request Window 
Import to Purchase Request Window 

 
From the View Bibliographic Record window by placing a check in the 
Masked checkbox: 
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From the MARC Editor window by placing a check in the Masked checkbox: 
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From the Add Purchase Request window by placing a check in the Masked 
checkbox: 

 

 
 

From the Import to Purchase Requests window by placing a check in the 
Masked checkbox: 
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From the Item Information window by placing a check in the Masked 
checkbox: 
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From the View Holdings Record window by placing a check in the Masked 
checkbox: 

 

 

Masking Statuses 
Under certain circumstances, you may wish to set record masking so that 
item record statuses do not display in the OPAC. For example, item records 

with the status missing. 
 

To configure a status to be masked go to the Global Settings tab, Status 
Displays option in the Virtua Profiler. On the General tab of the Statuses 
window enter a status descriptor, click the Mask Status checkbox, and click 

Save. 
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Display Masked Records 
If the bibliographic record for War and Peace is masked: 

 
A user with permission to view masked records will see the following results 
of a title browse search for War and Peace. 

 

 
 

A user without permission to view masked records will see the following 
results of a title browse search for War and Peace. 
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Patron Records 
 

Recommended 
Workflow 

 
Explanation 

 Patron information can also be viewed using the OPAC.  
Your library decides whether or not patrons will be 
allowed to view their patron records and check out 

materials from the OPAC.   

Summary 

Retrieve a patron record 
Navigate the search results 
View patron records 

 

Key Terms 

Patron Account tab 
Patron Activity tab 

Patron Empowerment 
Patron Information window 
Patron Record 

 
 

 

Access 
Patron 

Record 

View Patron 

Information 
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Access Patron Record 

Browse Search 
On the Browse tab you can initiate a patron name search. 
 

To perform a Browse search, click the Search icon . The Search 

window appears, displaying the Browse tab.  

 
To access a patron’s record, select Patron Name from the drop-down list 
box.   

 

 
 

Type the patron’s name (Last Name, First Name) in the search box and 
press the Search button or Enter key.   

 

The browse screen will display a list of patrons closest to the name searched. 
Click the desired patron and you will be taken to the Patron Information 

window. 
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Patron Keyword Search 
Patron searches let you search for patron records using keywords found in 

indexed patron information fields. The Patron tab of the Search window lets 
you use multiple search categories and search operators to operators to 
search for patrons, allowing more flexibility than the standard Patron Name 

Browse search or Patron ID Control Number search. 
 

Important: Patron keyword search functionality is a special Virtua feature 
that must be configured by VTLS personnel. To enable patron search 
functionality for your library, contact your local VTLS office. 

 
To perform a patron search: 

 

Click the Search icon  on the OPAC toolbar. 

 
The Search window appears, displaying the Browse tab. Click the 

Patron tab. 
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Using a combination of search terms, search categories, and search 

operators, construct a patron search query.  
 

Click the Search button.  
 
Your search results appear on either the Patron Search Results window or 

the Patron Information window. 
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View Patron Information 
 

Click on the Patron Activity tab to view current circulation transactions.  

 

 
 

Use the right mouse click to access the Patron Check-out window.  
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Appendix A: Definition of Key 
Terms 
 

Attribute Configuration: In order for Virtua to recognize non-standard 
Z39.50 use attributes it is necessary to configure them in the Server Setup 
window. This setting is for use when searching non-Virtua databases and is 

optional. 
 

Authority Heading: terms (authors/names, titles, or subjects) that are 
stored in authority record fields and appear in an alphabetical index on the 
Virtua Browse window. 

 
Bib-Level Call Number: the call number for the bibliographic record; which 

can be different from the call numbers of items associated with the record. 
 
Blind Reference: valid heading that appears in a browse index, but does 

not lead to any bibliographic records because there are no associated hits in 
the database. 

 
Boolean Operators: method of combining terms in a keyword search that 
allows the searcher to use three logical commands (AND, OR, NOT), 

sometimes called operators. 
 

Browse Window: window that contains the results of an OPAC Browse 
Search. 
 

Browse Search: type of OPAC search where the system retrieves all 
headings in the database that match or come close to matching the terms a 

user enters for a selected category. 
 
Call Number: identification code used to arrange items in order on the shelf. 

Call numbers are usually composed of two parts: 1) classification (located in 
subfield $a of the MARC tag), and 2) item or book number (located in 

subfield $b of the MARC tag). Call numbers are found in the 050 tag (LC) and 
080 tag (Dewey), and in 900 tags (locally defined) of the Bibliographic MARC 

record. 
 
Control Number: unique numbers assigned to library items or attached to 

catalog records and used to identify those items or records, for example, 
ISBN, ISSN, and LCCN. 

 
Control Number Search: a Virtua feature that provides direct access to 
records and items; control numbers are unique to a record so this type of 

search will retrieve only one record. The window in which the search result 
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displays is dependent on the type of control number; for example, a patron 
number search will display in the Patron Information window. 

 
Course ID: character string used to identify an academic course (e.g. 

HISTORY 101) in the Reserves module. Course ID is one of the Browse 
search categories in the Virtua OPAC. 
 

Cross-References: heading that appears in a Browse index because it 
exists as a 4xx tag or a 5xx tag in the authority record for a valid heading. 

The valid heading is stored in the 1xx tag in the authority record. When 
selected by the user, cross-reference headings refer the user to the valid 
heading 

 
Default Load Character Set: If a server returns records in a syntax other 

than MARC 21, Virtua uses the syntax specified here. Currently, the Virtua 
client accepts records from a server in MARC 21, CATMARC, and UNIMARC 
formats. 

 
Display Options: settings a user can choose for a session; fonts, language, 

and supplementary authority information (blind reference, authority source, 
heading type). You can enable or disable these display options at any point 

during your session. 
 
Expert Search: allows the experienced user to build sophisticated searches 

using search categories, keywords, Boolean operators (AND, OR, NOT), 
precedence, proximity, and truncation. 

 
Filters: criterion a user can set to restrict an OPAC search and thus limit the 
result set. Possible filters are: Location (library), Format, Language, 

Publication Year, Nature of Contents, and Place of Publication. 
 

Full Text Searching: using the program DocumentBatchLoader.ksh, your 
library can load text documents into the database and index them for 
keyword searching. When you use the Full Text keyword search category, 

Virtua searches for your keyword in any text document that has been 
indexed. 

 
Full Tab: (Bibliographic Record): displays the non-MARC public view of 
bibliographic information for a given record. 

 
Full Tab: (Holdings Record): displays bibliographic/holdings information 

along with the volumes and issues of a particular serial that the library or 
location houses. 
 

Holdings-level Call Number: Call number that is specific to a holdings 
record and is different from the call number on the associated bibliographic 

record or on other holdings records associated with the same bibliographic 
record. 
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Holdings MARC Record: Type of MARC record used in Virtua to describe 

serials. Holdings records contain the following elements: a link to the 
bibliographic record, location, prediction pattern, and issue level holdings 

information. 
 
Holdings Tab: tab on the View Record window that displays holdings record 

information associated with the bibliographic record. The header of the 
holdings tab contains elements of the bibliographic record and associated 

library-defined labels such as author, title, edition, publisher, and description 
of material; the list box contains columns of information taken from each 
holdings record and other records linked to the holdings record.  

 
Host Name: the IP address or the host name of the service (i.e. 

zeus.library.edu). 
 
Item: unique physical or virtual piece or entity, e.g., a book, volume of a 

journal, a roll of microfilm, etc. that is part of a library’s collection. 
 

Item Elements Tab: tab on the Item Information window that displays 
basic descriptive information for the item, such as Item Information, Call 

Number Information, and Circulation Rules. 
 
Item Information Window: displays data associated with the item record 

on up to four tabs, depending on the item class and the user profile: Item 
Elements, Statistics, Status and Notes. The Status tab appears only if the 

item has a status associated with it or if the Item Information window is in 
edit mode. The Notes tab appears only if the item has a public, staff, check-
in, or check-out notes associated with it or if the Item Information window is 

in edit mode. 
 

Item record: A record attached to a bibliographic record or holdings record 
that describes an individual item belonging to the library.  Item records 
contain information unique to the item such as call number, price, shelving 

location, etc. 
 

Item Tab: tab on the View Record window that displays the physical and/or 
virtual items associated with the bibliographic record, including: outstanding 
requests, location, call number, and barcodes. 

 
Item-Level Call Number: call number that appears on an individual item 

record (and 
correspondingly, on an actual physical item). An item-level call number is 
specific to an item. Libraries use this type of call number to uniquely identify 

multiple item records that are associated with a bibliographic record, which 
has a different call number from each of the items (see also Call Number). 
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Keyword in Heading Search: A type of OPAC keyword search that lets you 
search for keywords anywhere within an authority heading. The results of a 

Heading search appear on the List of Headings window, which resembles the 
Browse window but displays only the authority headings that contain your 

search term. 
 
Keyword Search: type of OPAC search that allows users to enter search 

terms with Boolean operators. Filters and left, right and medial truncation 
may also be applied to a keyword search. 

 
List of Titles: Displays brief bibliographic information about each title that is 
a qualified hit from a browse search. 

 
Location: (see shelving location) 

 
MARC 856 tag: tag is used to support multimedia files, containing images, 
video clips, sound recordings, or full text and which may reside on a local 

hard drive, a remote server, the Internet, or a CD-ROM. The views in the 
Profiler can be configured so that these files appear as hyperlinks on the Full, 

Items and Holdings tabs of the View Record window. 
 

MARC Authority Record: type of MARC record that indicates the main 
(authoritative or established) name (form) of an author and lists variations of 
that name, OR indicates the main title of a book and lists variations of that 

title, OR indicates the main way to refer to a subject and lists variations of 
ways to refer to that subject. 

 
MARC Bibliographic Record: type of MARC record that describes an item 
held by the library in MARC bibliographic format, and may contain the 

following descriptive elements: title and statement of responsibility (author, 
editor etc.), edition, material type, publisher/distributor, publication date, 

physical characteristics, series, notes, standard number (ISBN, ISSN, etc.), 
and terms of availability, including price. 
 

MARC Community Record: type of MARC record that describes a non-
bibliographic entity that provides information related to a civic community. 

Examples include individual people (e.g., storytellers, civic leaders, etc.), 
organizations, programs (e.g., a driver’s education class), event (e.g., a 
seminar), or some other entity (e.g., a facility such as a planetarium). 

 
MARC Tab: tab on the View Holdings Record window that displays a 

combination of bibliographic and holdings information. The MARC tab 
includes all the fields of the MARC holdings preceded by the following fields 
from the parent bibliographic record: 004, 010, 022, 030, 035, indexed call 

number, 1xx, 245, 246, 260, 780, 785. Note that when a holdings record 
opens in the MARC Editor, only the holdings fields appear. 
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Masked Record: Records that are hidden for some reason, often because 
they are on order. Records that are masked will not appear in the results of 

searches performed by users who do not have permission to view masked 
records (usually library patrons). 

 
Multiple Subject Heading Search: is based on the second indicator of the 
6xx tag of the MARC record, which generates a subject code in position 11 of 

the 008 of the authority record. 
 

OPAC: Online Public Access Catalog: it is one of the subsystems in Virtua. 
 
Patron Account Tab: fees owed by a specific patron are displayed on the 

Patron Account tab of the Patron Information window. 
 

Patron Activity Tab: a patron’s borrowing activity displays on the Patron 
Activity tab of the Patron Information window, (e.g. checked-out items, 
overdues, and pending requests). 

 
Patron Empowerment: optional Virtua features that allow patrons to make 

requests, check-out materials, and edit their own patron records.  
 

Patron Information Window: displays a patron’s personal data in Full or 
MARC Format, borrowing activity, and fees owed. 
 

Patron Record: database record in 2709 MARC Communications format 
(defined by VTLS, rather than by USMARC) that houses all of the identifying 

information about a library patron such as name, address, phone number, 
date of birth, patron barcode number, borrowing activity, and account 
activity. 

 
Port: An entrance to, or exit from, a data network. In Virtua it is the number 

used to access the server housing a Virtua database. Z39.50 servers often 
use the port number 210; otherwise, four- or five-digit port numbers 
between 1025 and 32767 are used. 

  
Profile Name: the name of the server or any other descriptive information 

that will identify the server the database is located on. Once the setup is 
configured this is the information that appears in the dropdown menu of 
available servers. 

 
Refine Search: a bibliographic keyword search query that Virtua combines 

with your original search query to produce a new (usually narrower) set of 
search results. 
 

See Reference: points from an invalid heading to the valid, authoritative 
heading. On the Browse window, the minus (-) sign next to a heading 

indicates a See cross-reference. 
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See Also Reference: points from a related heading to another related 
heading, both of which are valid. On the Browse window, the plus (+) sign 

next to a heading indicates a See also cross-reference. 
 

Search Categories: categories or indexes defined in Virtua which are used 
for searching the OPAC, for example, a: (author), t: (title). 
 

Search Strings: a series of keywords, Boolean operators, and/or 
parentheses that define a search. For example: (a:Mitchell)  +  (t:gone & 

t:wind) 
 
Search Window: window in the Virtua client from which a user can choose 

to do a Browse, Keyword, Control Number, or Expert search. 
 

Selection List: A list of materials recommended for purchase. In Virtua 
items for selection lists can be submitted electronically and integrated into 
the Acquisitions sub-system. 

 
Shelving Location: physical or virtual location of library material; main 

locations and sub-locations are defined in the Global Settings parameters in 
the Virtua Profiler. The shelving location is used to tell patrons where to 

locate the item and also as a filter in keyword and expert searches. 
 
Sort Order: order in which a set of search results appears on a results 

window. The standard value of the default sort on the List of Titles window is 
a title sort. A user can customize the default sort by clicking the Sort button. 

In a future release, a library can set the default sort on the List of Titles via a 
parameter setting. 
 

Statistics Tab: tab on the Item Information window that displays statistical 
data about the item: Bibliographic Information, Record Information, and 

Circulation Statistics. 
 
Statuses Tab: tab on the Item Information window that displays the 

purchase order number, order line item number, details about the purchase 
order and line item, receipt, invoice, payment, and credit status information. 

 
Subject headings: a controlled vocabulary used in subject cataloging and 
indexing by libraries or indexing agencies. 

 
Subject Thesaurus: a controlled vocabulary designated by a specific 

organization or agency.  Examples include National Agriculture Library (NAL), 
Medical Subject Heading (MeSH), and Art and Architecture. 
 

Sub-location: a department or specific location within a building or 
organizational unit, and represented by the last four digits of a unique nine-

digit library location code. Location filtering in the OPAC is allowed at both 
main location and sub-location levels. 
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Truncation: ability to search on part of a word. Virtua uses the symbol * to 

represent an unknown number of letters and a ? to represent a single letter. 
For example, Farm* will retrieve records that contain the terms farm, farms, 

farmer, farming, etc. 
 
Vendor Record: field-based format that contains vendor information to 

describe an organization from which library materials are ordered. 
 

View Record Window: shows data your library chooses to display for 
bibliographic records. From the Items tab and the Holdings tab of the View 
Record window, it is possible to navigate to a specific item record or holdings 

record. 
 

Virtua Client: refers to the Virtua Windows-based graphical user interface 
that resides on your PC and lets you access each subsystem in Virtua such as 
the OPAC subsystem. 

 
Z39.50 Database: A database that allows access through the Z39.50 

protocol. 
 

Z39.50 Protocol: national information retrieval standard developed by the 
National Information Standards Organization (NISO). It defines a protocol 
that allows one computer (the client) to communicate with another (the 

server), perform searches, and retrieve records. 
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Appendix B: InfoStation 
Reports for OPAC 
                                               

OPAC Report Group Notice Function 

   

OPAC Search 
Statistics 

N The OPAC Search Statistics report generates 
counts of various types of OPAC searches 

performed by the users, at the locations, and 
during the date range that you specify for the 

report configuration. Additionally, you can 
optionally choose for the report to display 
each count as a percentage of the total for a 

given category. 

   

Server Response 

Times 

N Generates a summary of the response times 

of the Virtua server to all Z39.50 search 
requests. 
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Appendix C: OPAC in a 
Consortium Environment 
 

Users 
User Profiles in the Profiler let you define the username, password, 

description, default log-in location, and group membership for each Virtua 
user. Additionally, the User Profiles parameter lets you configure user 

permissions. Permissions determine which functions, actions, and controls 
each Virtua user or group of users has permission to access or execute.  
 

Views 
 
Windows in the Virtua client display bibliographic, holdings, item, and patron 
data elements based on the tags, subfields, fixed fields, and other 

information defined in the Client Views in the Profiler.  In the consortium 
environment, each institution can configure its own set of Client  and iPortal 

Views. 
 

Filtering Out Holdings Records 
 

In the consortium environment, institutions can set their OPAC Display 
Options in the Virtua client to filter out those holdings records in the View 
Bibliographic Record window that belong to locations outside their 

institution. This allows users in the Virtua client to toggle between showing 
"all" holdings and showing just the holdings for their institution.  
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Appendix D: Commonly Used 
Search Categories 
 

a Author 
t Title 
s Subject 

tse Series Title 
p Publisher 

pp Place of Publication 
nte Notes 
lang Language 

ty Type 
ed Entered Date 

cs Cat Source 
bl Bibliographic Level 
tym Type of Material 

nc Nature of Content 
rs Rec Status 

ar Archive 
el Enc. Level 
d Desript 

lr Link Rec 
f Format 

td Type of Date 
sd Start Date 
edt End Date 

mr Mod Rec 
fr Frequency 

r Regularity 
ta Target Audience 
gp Govt Publication 

cp Conf Publication 
 

i Index1 
il Illustrations 
fst Festschrift 

fic Fiction 
b Biography 

tc Type of Computer File 
rf Relief 
pj Projection 

pm Prime Meridian 
ct Cartographic 

sf Special Format 
fc Form of Composition 
fm Format of Music 

mm Matter of Music 
lt Literary Text SR 

tm Time MP VR 
mv Matter Visual 
tq Technique 

ic ISSN Center 
ts Type of Serial 

foi Form of Original Item 
new Nature of Entire Work 
oa Original Alphabet 

aw Anywhere 
loc Location 

temp User Defined Search 1 
ud02 User Defined Search 2 
ud03 User Defined Search 3 

 

 
 

 
 



101 
 

OPAC Workflow-Based Reference Guide   Last Revised: October 2017 

*Updated to 16.1 

Appendix E: Multiple Subject 
Thesauri  
 

Virtua gives libraries the ability to add to the browse search dropdown menu 
specified thesauri searches in addition to the general subject search.  For 
further information, consult the Multiple Subject Thesauri white paper. 

 
The indexes are set in the Profiler using the Cataloging Multiple Subject 

Headings Parameter. 
 
1. A script is run against the database to identify existing library-defined 

thesauri codes and to identify improperly cataloged records: those with a 
conflict between the 2nd indicator in the bib record and position 11 of the 

008 tag in the authority record. 
2. After a second script fixes any reported records, the Multiple Subject 

Headings Parameter is set in the Profiler. 

3. A third script is run against the database to create the indexes. 
 

Thesauri searches are based on the second indicator of the 6xx tag of the 
MARC record, which generates a subject code in position 11 of the 008 tag of 
the authority record. 

 



102 
 

OPAC Workflow-Based Reference Guide   Last Revised: October 2017 

*Updated to 16.1 

Browse 
Dropdown Subject Thesaurus 

2nd 
ind. of 

bib 
record 

Bib 6xx 
$2 or  

Auth 040 
$f 

008/11 

of Auth 
Record 

Subject-blank Blank ‘blank’  ‘blank’ 
Subject-lcsh Library of Congress Subject 

Headings (LCSH) 

0  a 

Subject-
lcshac 

LC subject headings for children’s 
literature 

1  b 

Subject-MeSH Medical Subject Headings (MeSH) 2  c 
Subject-NAL National Agricultural Library subject 

authority file (NAL) 

3  d 

Subject-
Unknown 

Source not specified 4  4 

Subject-
Canadian 

Canadian Subject Headings 5  k 

Subject- 
Répertoire 

Répertoire de vedettesmatière 6  v 

Subject-Art Art and Architecture Thesaurus 7 aat r 

Subject-Sears Sears List of Subject Headings 7 sears s 
Subject-Value Source specified in bib $2 or auth 

040 $f 

7 ‘value’ z 

Subject-
Local1 

Locally defined 8  8 

Subject-
Local2 

Local 9  9 

 
NOTE: When saving a bib record, the 008/position 11 of the authority record 

is automatically populated based on the 2nd indicator on the 6xx tag. 
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Appendix F - Changes in this 
Guide 
 

Changes for Version 16.1 

 
No changes were made. 
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